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Note the following details of the code protection feature on Microchip devices:
� Microchip products meet the specification contained in their particular Microchip Data Sheet.

� Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 
intended manner and under normal conditions.

� There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our 
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip�s Data 
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

� Microchip is willing to work with the customer who is concerned about the integrity of their code.

� Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 
mean that we are guaranteeing the product as �unbreakable.�

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip�s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.
Information contained in this publication regarding device
applications and the like is provided only for your convenience
and may be superseded by updates. It is your responsibility to
ensure that your application meets with your specifications.
MICROCHIP MAKES NO REPRESENTATIONS OR WAR-
RANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED,
WRITTEN OR ORAL, STATUTORY OR OTHERWISE,
RELATED TO THE INFORMATION, INCLUDING BUT NOT
LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE,
MERCHANTABILITY OR FITNESS FOR PURPOSE.
Microchip disclaims all liability arising from this information and
its use. Use of Microchip devices in life support and/or safety
applications is entirely at the buyer�s risk, and the buyer agrees
to defend, indemnify and hold harmless Microchip from any and
all damages, claims, suits, or expenses resulting from such
use. No licenses are conveyed, implicitly or otherwise, under
any Microchip intellectual property rights.
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dsPICDEM� 80-PIN STARTER
DEVELOPMENT BOARD USER�S GUIDE
Preface
INTRODUCTION
This preface contains general information that will be useful to know before you use the 
dsPICDEM� 80-Pin Starter Development Board. Items discussed in this chapter include:
� Document Layout
� Conventions Used in this Guide
� Warranty Registration
� Recommended Reading
� The Microchip Web Site
� Development Systems Customer Change Notification Service
� Customer Support
� Document Revision History

DOCUMENT LAYOUT
This document describes how to use the dsPICDEM 80-Pin Starter Development 
Board as a development tool to emulate and debug firmware on a target board. The 
manual is organized as follows:
� Chapter 1: Introduction � This chapter introduces the dsPICDEM 80-Pin Starter 

Development Board and provides a brief description of the hardware.
� Chapter 2: Tutorial � This chapter details the step-by-step process for getting 

the dsPICDEM 80-Pin Starter Development Board up and running with the 
MPLAB® In-Circuit Debugger 2 (MPLAB ICD 2).

� Chapter 3: Demonstration Program Operation � This chapter describes the 
operational functionality of the sample code that is preprogrammed into the 
dsPIC30F device.

� Chapter 4: dsPICDEM� Development Board Hardware � This chapter describes 
the hardware comprising the dsPICDEM 80-Pin Starter Development Board.

� Appendix A: Hardware Schematics � This appendix provides dsPICDEM 
80-Pin Starter Development Board hardware layout and schematic diagrams.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a �DS� number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
�DSXXXXXA�, where �XXXXX� is the document number and �A� is the revision level.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available on-line help files.
© 2006 Microchip Technology Inc. DS51584B-page 1
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CONVENTIONS USED IN THIS GUIDE
This manual uses these documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User�s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

�Save project before build�

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N�Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4�b0010, 2�hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier font:
Plain Courier Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS51584B-page 2 © 2006 Microchip Technology Inc.



Preface
WARRANTY REGISTRATION
Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending in the Warranty Registration Card entitles users to receive new product 
updates. Interim software releases are available on the Microchip web site 
(www.microchip.com).

RECOMMENDED READING
This user's guide describes how to use the dsPICDEM 80-Pin Starter Development 
Board. Other useful Microchip documents that are available and recommended as 
supplemental reference resources include:
Readme for dsPICDEM 80-Pin Starter Development Board
For the latest information on using dsPICDEM 80-Pin Starter Development Board, read 
the �Readme for dsPICDEM 80-Pin Starter Development Board.txt� file (an ASCII 
text file) in the Readmes subdirectory of the MPLAB IDE installation directory. The 
Readme file contains update information and known issues that may not be included in 
this user�s guide.
Readme Files
For the latest information on using other tools, read the tool-specific Readme files in 
the Readmes subdirectory of the MPLAB IDE installation directory. The Readme files 
contain update information and known issues that may not be included in this user�s 
guide.
dsPIC30F Family Reference Manual (DS70046)
Consult this document for detailed information on dsPIC30F device operation. This 
reference manual explains the operation of the dsPIC30F Digital Signal Controller 
(DSC) family architecture and peripheral modules but does not cover the specifics of 
each device. Refer to the appropriate device data sheet for device-specific information.
dsPIC30F/dsPIC33F Programmer�s Reference Manual (DS70157)
This manual is a software developer�s reference for the dsPIC30F and dsPIC33F 16-bit 
DSC family of devices. It describes the instruction set in detail and also provides 
general information to assist in developing software for these dsPIC® DSC families.
dsPIC33F Family Data Sheet (DS70165)
Consult this document for detailed information on dsPIC33F Digital Signal Controllers.  
Reference information found in this data sheet includes:
� Device memory map
� Device pinout and packaging details
� Device electrical specifications
� Overview of peripherals included in the device
PIC24H Family Data Sheet (DS70175)
Consult this document for detailed information on the PIC24H 16-bit MCU family.  
Reference information found in this data sheet includes:
� Device memory map
� Device pinout and packaging details
� Device electrical specifications
� Overview of peripherals included in the device
© 2006 Microchip Technology Inc. DS51584B-page 3
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PIC24FJ128GA Family Device Data Sheet (DS39474)
Consult this document for detailed information on the PIC24FJ128GA 16-bit MCU.  
Reference information found in this data sheet includes:
� Device memory map
� Device pinout and packaging details
� Device electrical specifications
� Overview of peripherals included in the device
dsPIC30F6011A/6012A/6013A/6014A Data Sheet (DS70143)
Consult this document for detailed information on dsPIC30F6011A, dsPIC30F6012A, 
dsPIC30F6013A and dsPIC30F6014A Digital Signal Controllers. Reference 
information found in this data sheet includes:
� Device memory map
� Device pinout and packaging details
� Device electrical specifications
� Overview of peripherals included in the device
MPLAB® ASM30, MPLAB® LINK30 and Utilities User�s Guide (DS51317)
This document details Microchip Technology�s language tools for dsPIC DSC devices 
based on GNU technology. The language tools discussed are:
� MPLAB ASM30 Assembler
� MPLAB LINK30 Linker
� MPLAB LIB30 Archiver/Librarian
� Other Utilities
MPLAB® C30 C Compiler User�s Guide (DS51284)
This document details the use of Microchip�s MPLAB C30 C Compiler for dsPIC DSC 
devices to develop an application. MPLAB C30 is a GNU-based language tool, based 
on source code from the Free Software Foundation (FSF). For more information about 
the FSF, see www.fsf.org.
Other GNU language tools available from Microchip are:
� MPLAB ASM30 Assembler
� MPLAB LINK30 Linker
� MPLAB LIB30 Librarian/Archiver
MPLAB® IDE, Simulator, Editor User�s Guide (DS51025)
Consult this document for more information pertaining to the installation and 
implementation of the MPLAB Integrated Development Environment (IDE) Software. 
To obtain any of these documents, contact the nearest Microchip sales location (see 
back page) or visit the Microchip web site at www.microchip.com.
DS51584B-page 4 © 2006 Microchip Technology Inc.



Preface
THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
� Product Support � Data sheets and errata, application notes and sample 

programs, design resources, user�s guides and hardware support documents, 
latest software releases and archived software

� General Technical Support � Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

� Business of Microchip � Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE
Microchip�s customer change notification service helps keep customers current on 
Microchip products. Subscribers will receive e-mail notification whenever there are 
changes, updates, revisions or errata related to a specified product family or 
development tool of interest.
To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.
The Development Systems product group categories are:
� Compilers � The latest information on Microchip C compilers and other language 

tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM� 
and MPLAB ASM30 assemblers; MPLINK� and MPLAB LINK30 object linkers; 
and MPLIB� and MPLAB LIB30 object librarians.

� Emulators � The latest information on Microchip in-circuit emulators. This 
includes the MPLAB ICE 2000 and MPLAB ICE 4000.

� In-Circuit Debuggers � The latest information on the Microchip in-circuit 
debugger, MPLAB ICD 2.

� MPLAB® IDE � The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 
and general editing and debugging features.

� Programmers � The latest information on Microchip programmers. These include 
the MPLAB PM3 and PRO MATE® II device programmers and the PICSTART® 
Plus and PICkit� 1 development programmers.
© 2006 Microchip Technology Inc. DS51584B-page 5
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CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
� Distributor or Representative
� Local Sales Office
� Field Application Engineer (FAE)
� Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (October 2005)
� Initial Release of this Document.

Revision B (March 2006)
� Updated document to include dsPIC33F Digital Signal Controllers, and PIC24F 

and PIC24H MCU information.
DS51584B-page 6 © 2006 Microchip Technology Inc.



dsPICDEM� 80-PIN STARTER
DEVELOPMENT BOARD USER�S GUIDE
Chapter 1.  Introduction
1.1 INTRODUCTION
The dsPICDEM 80-Pin Starter Development Board is a development kit and evaluation 
tool for dsPIC high-performance DSCs and PIC24 MCUs.

1.2 HIGHLIGHTS
This chapter discusses:
� dsPICDEM 80-Pin Starter Development Board Kit Contents
� dsPICDEM 80-Pin Starter Development Board Functionality and Features 
� dsPICDEM 80-Pin Starter Development Board Demonstration Program
� Reference documents

1.3 dsPICDEM 80-PIN STARTER DEVELOPMENT BOARD KIT CONTENTS
The following items comprise the dsPICDEM 80-Pin Starter Development Board Kit:
� The dsPICDEM 80-Pin Starter Development Board printed circuit board 

(see Figure 1-1).
� A preprogrammed dsPIC30F6014A device soldered onto an adapter board, which 

plugs into the Emulation Header on the dsPICDEM 80-Pin Starter Development 
Board (see Figure 1-2). 

� dsPICDEM 80-Pin Starter Development Board CD-ROM containing various 
demonstration programs provided by Microchip.

Note: The term dsPIC DSC used throughout this manual refers to both the 
dsPIC30F and dsPIC33F device families. Unless specified otherwise, 
these devices can be used interchangeably. Similarly, the term PIC24 MCU 
refers to both the PIC24F and PIC24H device families.
© 2006 Microchip Technology Inc. DS51584B-page 7
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FIGURE 1-1: dsPICDEM� 80-PIN STARTER DEVELOPMENT BOARD   

FIGURE 1-2: TYPICAL PLUG-IN MODULE (PIM)

For information on the components used on the dsPICDEM 80-Pin Starter 
Development Board see Chapter 4. �dsPICDEM� Development Board Hardware�.
DS51584B-page 8 © 2006 Microchip Technology Inc.



Introduction
1.4 FUNCTIONALITY AND FEATURES
The dsPICDEM 80-Pin Starter Development Board provides the following capabilities:

Development Board Power 
� On-board variable voltage regulator for 3.3V and 5.0V output with direct input from 9V, 

AC/DC wall adapter
� 9 VDC power source input jack for development board
� Power-on indicator LED

MPLAB ICD 2 and MPLAB ICE 4000 Connections
� MPLAB ICD 2 programming connector
� Emulation header for connection to MPLAB ICE 4000
� Pad location for 80-pin TQFP dsPIC DSC device

Serial Communication Channel
� Single RS-232 communication channel

Analog
� One 10 kΩ Potentiometer (RP2)
� Microchip MCP41010 Digital Potentiometer
� Microchip MCP6022 Operational Amplifier 

- Output configured as low-pass filter for digital potentiometer
- Input configured as low-pass filter for sampling input signals with the ADC

Device Clocking
� 7.37 MHz crystal (Y1) for dsPIC DSC device

Miscellaneous
� Reset push button switch (S3) for resetting the dsPIC DSC device
� Four red LEDs (RD4-RD7)
� Two push button switches (S1-S2) for external input stimulus
� 80-pin dual-row header with labeled pinouts.
� Prototype area for user hardware
� Supports 100-to-80-pin dsPIC33F and PIC24 Plug-in Modules

1.5 dsPICDEM 80-PIN STARTER DEVELOPMENT BOARD DEMONSTRATION 
PROGRAM

The dsPICDEM 80-Pin Starter Development Board is supplied with a pre-loaded 
demonstration program that exercises principal CPU functions and peripheral options 
that allow interaction with the program as follows:
� Demonstrates interrupt handling by using switches S1 and S2 to blink LEDs RD4 

and RD5, respectively.
� Demonstrates digital-to-analog conversion by generating an audio tone on LINE 

OUT.
� Demonstrates analog-to-digital conversion by adjusting Potentiometer RP2 and 

transmitting the resulting digital value to the HyperTerminal on a PC.
Refer to Chapter 3. �Demonstration Program Operation� for details on the 
demonstration code operation.
© 2006 Microchip Technology Inc. DS51584B-page 9
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1.6 REFERENCE DOCUMENTS
The following documentation is available to support the use of the dsPICDEM 80-Pin 
Starter Development Board:
� �dsPIC30F Family Reference Manual� (DS70046)
� �dsPIC30F Family Reference Manual Errata� (DS80169)
� �dsPIC30F/33F Programmer�s Reference Manual� (DS70157)
� �dsPIC30F6011A/6012A/6013A/6014A Data Sheet� (DS70143)
� �dsPIC33F Family Data Sheet� (DS70165)
� �PIC24H Family Data Sheet� (DS70175)
� �PIC24FJ1285A Data Sheet (DS39747)
� MPLAB® C30 C Compiler User�s Guide� (DS51284)
� �MPLAB® ASM30, MPLAB® LINK30 and Utilities User�s Guide� (DS51317)
� �Using MPLAB® ICD 2� poster (DS51265)
� �MPLAB® ICE Emulator User�s Guide� (DS51159)
You can obtain these reference documents from your nearest Microchip sales office 
(listed in the back of this document) or by downloading them from the Microchip web 
site (www.microchip.com).
DS51584B-page 10 © 2006 Microchip Technology Inc.
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Chapter 2.  Tutorial
2.1 INTRODUCTION
This chapter is a self-paced tutorial to get you started using the dsPICDEM 80-Pin 
Starter Development Board.

2.2 HIGHLIGHTS
Items discussed in this chapter include:
� Tutorial Overview
� Creating the Project
� Building the Code
� Programming the Chip
� Debugging the Code
� Summary

2.3 TUTORIAL OVERVIEW
The tutorial program in Eg1_BlinkLed.s is written in assembly code. This program 
blinks an LED when a key is pressed. The source file is used with a linker script file 
(p30f6014a.gld) and an include file (p30f6014a.inc) to form a complete project. 
This simple project uses a single source code file; however, more complex projects 
might use multiple assembler and compiler source files as well as library files and 
precompiled object files.
There are four steps to this tutorial:
1. Creating a project in MPLAB IDE.
2. Assembling and linking the code.
3. Programming the chip with the MPLAB ICD 2.
4. Debugging the code with the MPLAB ICD 2.

Note: The following tutorial instructions assume the use of the dsPIC30F6014A 
device, which is supplied with the dsPICDEM 80-Pin Starter Development 
Board. However, this information applies to any of the dsPIC30F,  
dsPIC33F, PIC24F and PIC24H devices supported by the board. 
© 2006 Microchip Technology Inc. DS51584B-page 11
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2.4 CREATING THE PROJECT
The first step is to create a project and a workspace in MPLAB IDE. Typically, there is 
one project in one workspace.

A project contains the files needed to build an application (source code, linker script 
files, etc.) along with their associations to various build tools and build options.
A workspace contains one or more projects and information on the selected device, 
debug tool and/or programmer, open windows and their location and other MPLAB IDE 
configuration settings.
MPLAB IDE contains a Project Wizard to help create new projects. Before starting, 
create a folder named Tutorial for the project files for this tutorial (C:\Tutorial is 
assumed in the instructions that follow). From the Example Code\Tutorial Code 
directory on the Development Kit Software CD-ROM, copy the Eg1_BlinkLed.s file 
into this folder. 

2.4.1 Select a Device
1. Start MPLAB IDE.
2. Close any workspace that might be open (File>Close Workspace).
3. From the Project menu, select Project Wizard.
4. From the Welcome screen, click Next to display the Project Wizard Step One 

dialog (see Figure 2-1). 

FIGURE 2-1: PROJECT WIZARD, STEP 1, SELECT A DEVICE

5. From the Device: pull-down list, select dsPIC30F6014A and click Next >. The 
Project Wizard Step Two dialog displays as shown in Figure 2-2.

Note: These instructions presume the use of MPLAB 7.20 or newer.
DS51584B-page 12 © 2006 Microchip Technology Inc.
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FIGURE 2-2: PROJECT WIZARD, STEP 2, SELECT LANGUAGE 
TOOLSUITE

2.4.2 Select Language Toolsuite
1. From the Active Toolsuite pull-down menu, select Microchip ASM30 Toolsuite. 

This toolsuite includes the assembler and linker that will be used (the C compiler 
is not used). 

2. In the Toolsuite Contents block, select MPLAB ASM 30 Assembler 
(pic30-as.exe).

3. In the Location block, click Browse... and navigate to:
C:\Program Files\Microchip\MPLAB ASM30 Suite\Bin\pic30-as.exe

4. With MPLAB LINK 30 Object Linker (pic30-Id.exe) selected in Toolsuite 
Contents, click Browse... and navigate to:
C:\Program Files\Microchip\MPLAB ASM30 Suite\Bin\pic30-ld.exe

5. Click Next > to continue. The Project Wizard Step Three dialog displays (see 
Figure 2-3).

Note: If you have the MPLAB C30 Toolsuite installed, browse to the  
C:\program files\microchip\MPLAB C30\bin\ location.
© 2006 Microchip Technology Inc. DS51584B-page 13
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FIGURE 2-3: PROJECT WIZARD, STEP 3, NAME YOUR PROJECT

2.4.3 Name Your Project
1. In the Project Name text box, type MyProject. 
2. Click Browse... and navigate to C:\Tutorial to place your project in the Tutorial 

folder.
3. Click Next > to continue. The Project Wizard Step Four dialog displays (see 

Figure 2-4).

FIGURE 2-4: PROJECT WIZARD, STEP 4, ADD FILES TO PROJECT 
DS51584B-page 14 © 2006 Microchip Technology Inc.



Tutorial
2.4.4 Add Files to Project
1. From the list of folders on the PC, locate the C:\Tutorial folder and select the 

Eg1_BlinkLed.s file.
2. Click Add>> to include the file in the project.
3. Expand the C:\Program Files\Microchip\MPLAB ASM30 

Suite\Support\gld folder and select the p30f6014a.gld file.
4. Click Add>> to include this file in the project. There should now be two files in 

the project. 
5. Click Next > to continue.
6. When the summary screen displays, click Finish.
After the project wizard completes, the MPLAB project window shows the 
Eg1_BlinkLed.s file in the Source Files folder and the p30f6014a.gld file in the 
Linker Scripts folder (see Figure 2-5).

FIGURE 2-5: PROJECT WINDOW

A project and workspace has now been created in MPLAB IDE. MyProject.mcw is 
the workspace file and MyProject.mcp is the project file. Double click the 
Eg1_BlinkLed.s file in the project window to open the file. MPLAB IDE should now 
look similar to Figure 2-6.

FIGURE 2-6: MPLAB® IDE WORKSPACE 

Project
Window

Output
Window

Source 

Window
Code
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2.5 BUILDING THE CODE
In this project, building the code consists of assembling the Eg1_BlinkLed.s file to 
create an object file Eg1_BlinkLed.o and then linking the object file to create the 
Eg1_BlinkLed.hex and Eg1_BlinkLed.cof output files. The HEX file contains the 
data necessary to program the device, and the .cof file contains additional information 
that lets you debug the code at the source code level.
Before building, there are settings required to tell MPLAB IDE where to find the include 
files and to reserve space for the extra debug code when the MPLAB ICD 2 is used.
The following line is near the top of the Eg1_BlinkLed.s file:

.include "p30f6014a.inc"
This line causes a standard include file to be used. Microchip provides these files with 
all the Special Function Register (SFR) labels already defined for convenience. 
To build the code, select Build Options>Project from the Project menu. The Build 
Options dialog displays (see Figure 2-7). 

FIGURE 2-7: BUILD OPTIONS 

Browse to the location of the 
Assembler Include file
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2.5.1 Identify Assembler Include Path
1. Select the General tab.
2. At the Assembler Include Path, $(AINDIR):box, click Browse... and navigate to:

C:\Program Files\Microchip\MPLAB ASM30 Suite\Support\inc

This path tells MPLAB IDE where to find the include files.
3. Select the MPLAB LINK30 tab to view the linker settings (see Figure 2-8).

FIGURE 2-8: MPLAB® LINK30 BUILD OPTIONS

2.5.2 Link for MPLAB ICD 2
1. Check Link for ICD 2.
2. Click OK. The text box closes while the linker reserves space for the debug code 

used by the MPLAB ICD 2.
3. Click OK again to save these changes. The project is now ready to build.

Check Link for ICD2
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2.5.3 Build the Project
1. From the Project menu, select Make. The Build Output window displays.
2. Observe the progress of the build.
3. When the BUILD SUCCEEDED message displays (see Figure 2-9), you are 

ready to program the device.

FIGURE 2-9: BUILD OUTPUT
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2.6 PROGRAMMING THE CHIP
The MPLAB ICD 2 In-Circuit Debugger is used to program and debug the 
dsPIC30F6014A device in-circuit on the dsPICDEM 80-Pin Starter Development 
Board.

Use the procedures in the following section to program the dsPIC30F6014A device.

2.6.1 Set Up The Device Configuration
1. Use the Configure>Configuration Bits menu to display the configuration settings. 
2. Set up the configuration bits, as shown in Figure 2-10. 

The settings that will most likely need to change are:

FIGURE 2-10: CONFIGURATION SETTINGS

2.6.2 Connect the MPLAB ICD 2 In-Circuit Debugger
1. Connect the MPLAB ICD 2 to the PC with the USB cable (see Figure 2-11).
2. Connect the MPLAB ICD 2 to the dsPICDEM 80-Pin Starter Development Board 

with the short RJ-11 (telephone) cable. 

3. Apply power to the board.

Note: Before proceeding, make sure that the USB driver for the MPLAB ICD 2 has 
been installed on the PC (see the �MPLAB® ICD 2 In-Circuit Debugger 
User�s Guide� (DS51331) for more details regarding the installation of the 
MPLAB ICD 2). 

Oscillator XT w/PLL 4x
Watchdog Timer Disabled

CAUTION

Before you apply power to the board, observe these voltage precautions:
If a dsPIC33F device is being used, J5 should be OPEN or OFF to enable 3.3V to the VDD 
or supply voltage. Operating a dsPIC33F device at 5.0V will cause a catastrophic failure 
of the device.
If a dsPIC30F device is being used, J5 can be open or closed. You will get 3.3V or 5.0V 
voltage to the VDD pin.
© 2006 Microchip Technology Inc. DS51584B-page 19



dsPICDEM� 80-Pin Starter Development Board User�s Guide
FIGURE 2-11: TYPICAL dsPIC® DSC DEVELOPMENT BOARD CONNECTED 
TO MPLAB® ICD 2

2.6.3 Enable MPLAB ICD 2 Connection
1. From the Debugger menu, click Select Tool>MPLAB ICD 2  to set the MPLAB 

ICD 2 as the debug tool in MPLAB IDE.
2. From the Debugger menu, select Connect to connect the debugger to the device. 

MPLAB IDE should report that it found the dsPIC30F6014A device, as shown in 
Figure 2-12.

FIGURE 2-12: ENABLING MPLAB® ICD 2 

Note: MPLAB IDE may need to download new firmware if this is the first time the 
MPLAB ICD 2 is being used with a dsPIC30F device. Allow it to do so. If 
any errors are shown, double click the error message to get more 
information.

Status indicates 
device is found
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2.6.4 Program the dsPIC30F6014A Device
1. From the Debugger menu, select Program to program the part. The output 

window (Figure 2-13) displays the program steps as they occur. 
2. Observe the results of the programming. When �MPLAB ICD 2 Ready� displays, 

the device is programmed and ready to run.

FIGURE 2-13: PROGRAMMING THE dsPIC® DSC DEVICE

3. Use the Debugger>Run menu to run the code. LED1 should start blinking when 
S1 is pressed.
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2.7 DEBUGGING THE CODE
The MPLAB ICD 2 In-Circuit Debugger is used to run, halt and step the code. A 
breakpoint can be set so that the program halts once the code has executed the 
instruction at the breakpoint. The contents of the RAM and registers can be viewed 
whenever the processor has been halted.
The MPLAB ICD 2 In-Circuit Debugger uses the following function keys to access the 
main debugging functions:    

In addition, there are more functions available by right clicking on a line of source code. 
The most important of these are �Set Breakpoint� and �Run to Cursor�.

2.7.1 Display the Code
1. From the View menu, select the Program Memory menu.
2. On the Program Memory window, select the Symbolic tab, as shown in 

Figure 2-14.

FIGURE 2-14: PROGRAM MEMORY WINDOW 

3. Press <F5> to halt the processor and press <F6> to reset. The program memory 
now shows a green arrow pointing to the line of code at address 00000, the reset 
location.
The instruction at this location is goto _reset. This code is added by the linker 
to make the program branch to the start of the code in the Eg1_BlinkLed.s file. 
The code uses the _reset label at the start of the executable code and declares 
the label as global to have visibility outside the source file. See Example 2-1.

EXAMPLE 2-1: CODE START-UP

The linker also provides values for the __SP_init and __SPLIM_init 
constants to initialize the Stack Pointer (W15) since the linker determines what 
RAM is available for the stack.

<F5> Halt
<F6> Reset
<F7> Single Step
<F9> Run

.global __reset

..text
__reset: mov #__SP_init, W15 Pointer

mov #__SPLIM_init, W0
mov W0, SPLIM
DS51584B-page 22 © 2006 Microchip Technology Inc.



Tutorial
2.7.2 Step the Program
1. Press <F7> to single step the code. The green arrow moves to the code at 

__reset in the Eg1_BlinkLed.s source code, as shown in Figure 2-15.

FIGURE 2-15: SOURCE CODE WINDOW 

2. Right click the line of code mov W0,W14 and choose Run to Cursor. The green 
arrow moves to repeat #12 because it has executed the prior lines of code up 
to and including mov W0,W14.

3. From the View menu, select Watch to open a Watch window, and select 
RCOUNT in the Add SFR pull-down list. 

4. Click Add SFR to add the RCOUNT register to the Watch window. 
5. Press <F7> a few times and watch the RCOUNT value decrement (see 

Figure 2-16). RCOUNT is the repeat loop counter and decrements to zero as the 
instruction in a repeat loop is executed several times.

FIGURE 2-16: WATCH WINDOW DISPLAY 
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2.7.3 Set Breakpoint
1. To set a breakpoint, right click a code line and select Set Breakpoint from the 

pop-up menu. 

As an example, find the following line of code and set a breakpoint on this line:
Again:   btss   PORTA,#S1

A red stop sign should appear in the gutter (gray bar on the left) of the source 
code window. 

2. Press <F9> to run the code. The program halts on the instruction following the 
breakpoint as shown in Figure 2-17. 

FIGURE 2-17: SETTING BREAKPOINT 

In this example, every time <F9> is pressed to run the code, it sends one 
character to the display and stops at the breakpoint. After the first four spaces, 
the characters will start to appear on the LCD display.

2.8 SUMMARY
This tutorial demonstrates the main features of MPLAB IDE and MPLAB ICD 2 as they 
are used with the dsPICDEM 80-Pin Starter Development Board. Upon completing this 
tutorial, you should be able to:
� Create a project using the Project Wizard
� Assemble and link the code and set the Configuration bits
� Set up MPLAB IDE to use MPLAB ICD 2
� Program the chip with MPLAB ICD 2
� View the code execution in program memory and source code
� View registers in a Watch window
� Set a breakpoint and make the code halt at a chosen location
� Use the function keys to Reset, Run, Halt and Single Step the code

Note: An alternate method is to simply double click the line. This feature may 
need to be enabled in the Edit>Properties menu. 

Note: The instruction on which the code halts could be elsewhere in the code if 
the breakpoint is set on a branch or call instruction. Refer to Section 12 
titled �Important Notes� in the Readme for MPLAB ICD 2.txt file located 
in the C:\MPLAB IDE\READMES directory for additional operational 
information on the MPLAB ICD 2.
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Chapter 3.  Demonstration Program Operation
3.1 INTRODUCTION
The dsPICDEM 80-Pin Starter Development Board is shipped with example 
applications programmed into the dsPIC DSC device. These examples exercise 
several of the dsPIC DSC peripherals such as the 12-bit Analog-to-Digital Converter 
(ADC) and UART interfaces. This chapter provides an overview of the demonstration 
code. Detailed information on the dsPICDEM 80-Pin Starter Development Board 
hardware is presented in Chapter 4. �dsPICDEM� Development Board Hardware� 
and Appendix A. �Drawings and Schematics�.

3.2 HIGHLIGHTS
Items discussed in this chapter are:
� Demonstration Program Summary
� Demonstration Code Operation
� Board Self-test

3.3 DEMONSTRATION PROGRAM SUMMARY
The preprogrammed demonstration program includes two functionally separate code 
modules:
� Demonstration code module
� Board self-test code module
These two code modules have been combined into one composite program and coded 
into the device. The board self-test code module has been included on the CD as a 
library archive only and is briefly discussed at the end of this section. The following 
sections present the operation of each module.
When power is applied to the dsPICDEM 80-Pin Starter Development Board, the dsPIC 
DSC device begins executing the demonstration program, which consists of three 
distinct functional tasks: 
� Interrupt processing
� Analog-to-digital conversion
� Digital-to-analog conversion

3.3.1 Interrupt Processing
To illustrate interrupt processing, the demonstration program uses switches S1 and S2 
as signals to drive LEDs RD4 and RD5 (output devices). When switch S1 is pressed 
(to represent an interrupt), LED RD4 blinks at a 1 Hz rate (once per second) until switch 
S1 is pressed again. Similarly, when switch S2 is pressed, LED RD5 blinks until switch 
S2 is pressed again. Timer 1 is set up to interrupt every half second.
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The dsPIC DSC device functionality used in this demonstration program includes:
� Setting up I/O ports
� Setting up timer interrupts
� Handling interrupts
To observe this demonstration, close jumper J4 to enable the LEDs, then operate the 
switches.

3.3.2 Analog-to-Digital Conversion
To illustrate analog-to-digital conversion, the analog value of potentiometer R13 is 
converted by the Analog-to-Digital Converter, ADC12, to a digital value that is 
transmitted via UART1 to a PC.
When the HyperTerminal accessory in Microsoft Windows® is connected to the serial 
port on the dsPICDEM 80-Pin Starter Development Board, it receives and displays a 
stream of three-digit HEX codes that correspond to the 12-bit output value of ADC12. 
As the potentiometer R13 is adjusted, the displayed HEX code changes within a range 
from 000 to FFF.
The dsPIC30F device functionality used for this demonstration includes:
� Conversion of an analog signal to a 12-bit digital signal
� Conversion of the 12-bit ADC value to HEX and ASCII format
� UART communication handling
To implement this demonstration, connect the J1 connector on the dsPICDEM 80-Pin 
Starter Development Board to the RS-232 serial port on the PC with a DB9 cable. Using 
the HyperTerminal program available as a Microsoft Windows communications 
accessory, configure the serial port to 2400 baud, 8 bits with 1 stop bit, no parity and 
no flow control.

3.3.3 Digital-to-Analog Conversion
To illustrate digital-to-analog conversion, the dsPICDEM 80-Pin Starter Development 
Board uses the MCP41010 digital potentiometer and MCP6022 Operational Amplifier 
(configured as a low-pass filter) to deliver an audio tone to the LINE OUT pin. The 
digital input is derived from a table of HEX values in data memory. The demo program 
cycles through the table and delivers the selected value to the digital potentiometer via 
the Serial Peripheral Interface (SPI) module on the dsPIC DSC device. The table 
values cover the full range of the digital potentiometer.
The program communicates a new table value to the digital potentiometer every 125 
microseconds, which generates a 400 Hz audio signal out of the low-pass filter. 
Switches S1 and S2 are used to change the output frequency to 800 Hz and 1600 Hz, 
respectively.
The dsPIC DSC device functionality used for this demonstration includes:
� Mapping of data memory to program memory with PSV addressing
� Initialization of the SPI port
� Loading and transmission of data using hardware SPI
To observe this demonstration, connect an oscilloscope probe to pin 2 of J9 (the LINE 
OUT pin).
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3.4 DEMONSTRATION CODE OPERATION
The following sections describe in more detail how the demonstration programs 
interact with and take advantage of key dsPIC DSC, DSP and peripheral features. Full 
details on the peripheral functionality and associated tasks are presented later in this 
document.

3.4.1 Interrupt Processing 
The demonstration code samples switches S1 and S2 and uses their status to operate 
the LEDs associated with processor ports RD4 and RD5, respectively. If S1 is pressed, 
it sets program flag �LED1on�. If S1 is pressed again, it resets program flag LED1on. 
Similarly, if S2 is pressed, it toggles program flag LED2on.
Another interrupt routine checks flags LED1on and LED2on every 500 milliseconds. If 
the LED1on is true, the LED labeled RD4 is toggled on and off every 0.5 seconds, 
causing the LED to blink. If LED1on is not true, the LED remains off.
This demo program is illustrated in Figure 3-1. 

FIGURE 3-1: INTERRUPT PROCESSING FLOW DIAGRAM

START

INIT TIMER 1

LED1on = LED1onS1 Pressed?

S2 Pressed? LED2on = LED2on

S1 Released?

S2 Released?

Yes

No

Yes

Yes

Yes

Yes No

No

No

Start of 0.5 sec 
Timer1 Init

LED1on Flag Set? RD4 = RD4

Turn RD4 Off

LED2on Flag Set? RD5 = RD5

Turn RD5 Off

Return 

No

Yes

No

For 0.5 Sec Interval
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3.4.2 Analog-to-Digital Conversion
This program consists of two subroutines which (1) perform the A/D conversion and (2) 
transmit the converted value over an RS-232 serial connection (see Figure 3-2). The 
A/D conversion routine samples the analog output of Potentiometer RB2. The transmit 
routine converts the 12-bit binary value from ADC12 to a three-digit HEX code, 
converts the HEX code to an ASCII character and loads the ASCII value into the 
transmission buffer of UART1. UART1 transmits each ASCII character with a CR and 
LF to delimit each sample as a separate line on the receiving terminal.

FIGURE 3-2: ANALOG-TO-DIGITAL CONVERSION FLOW DIAGRAM

INIT ADC12
INIT UART

Start A/D 
Conversion

Convert HEX
Digit 3 to ASCII

ADC Complete?

Buffer Full? Load Digit 3 into 
Transmit Buffer

START

Delay 10 msec

Convert 12-bit Binary 
to 3-digit HEX

Convert HEX
Digit 2 to ASCII Buffer Full? Load Digit 2 into 

Transmit Buffer

Convert HEX
Digit 1 to ASCII Buffer Full? Load Digit 1 into 

Transmit Buffer

Generate ASCII
CR Buffer Full? Load CR into 

Transmit Buffer

Generate ASCII 
LF Buffer Full? Load Transmit 

Buffer

Yes

No

Yes

Yes

Yes

Yes

Yes

No

No

No

No

No
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3.4.3 Digital-to-Analog Conversion
This program uses Digital Potentiometer MCP41010 on the dsPICDEM 80-Pin Starter 
Development Board as a D/A converter to generate a sine-wave signal (audio tone) to 
the LINE OUT pin. The digital potentiometer is driven by the output of the serial 
peripheral interface SPI2 of the dsPIC30F6014A device, which receives its input from 
the program.
The program retrieves HEX values from a table in data memory and delivers it to the 
SPI. Thirty-two stored values cover the full range of the digital potentiometer. As the 
analog output of the digital potentiometer passes through the MCP6022 Operational 
Amplifier (configured as a low-pass filter) it results in a 400 Hz sine wave based on a 
new table value every 125 μsec covering all 32 table values. The sine wave is placed 
on the LINE OUT pin of the development board.
Figure 3-3 illustrates the digital-to-analog conversion process. Switches S1 and S2 are 
used to change the output frequency to 800 Hz and 1600 Hz, respectively, by skipping 
over some of the table values.

FIGURE 3-3: DIGITAL-TO-ANALOG CONVERSION PROGRAM FLOW
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3.5 BOARD SELF-TEST 
The board self-test is provided for completeness only. Users do not need to run this 
test.
1. Power the board using a 9V DC supply and the barrel power connector.

The LED marked D1 turns ON.
If D1 does not light:
- the LED is dead, or 
- the regulator is dead, or 
- the DC supply is not connected to the AC wall plug

2. Using a DMM set for DCV, check that 3.3V or 5.0V is available at location marked 
VDD and GND on the 80-pin header.

3. Connect a shorting plug on the RS-232 connector J1. This shorting plug should 
have pins 2 and 3 connected to one another.

4. Short pins 2 and 3 on line connector J9 using a 0.1″ jumper.
5. Make sure J4 has a 0.1″ jumper on it.
6. To enter the Self-Test mode, hold down S1, press and release MCLR, then 

release S1.
The following four tests should run:

Test Description

UART Test This automatic test transmits 5 characters and receives them through
the serial port. During the test, LED RD4 blinks at a very fast rate 
(8 blinks/sec). However, this test completes so quickly that, in most 
instances, no noticeable blink of RD4 will occur.

Keypad Test During this test, LED RD5 blinks very fast. You must respond by pressing 
S1 and S2. When you press S1, RD4 lights. When you press S2, RD7 
lights. If both key presses are acknowledged by the dsPIC® DSC, then 
the test passed. If you get no response or an incorrect response within 4 
seconds, then the test is considered failed. In either case the test 
automatically proceeds to the Potentiometer test.

Potentiometer Test During this test, LED RD6 blinks rapidly. You must first respond by turn-
ing Potentiometer R13 fully clockwise (RD4 will light) and then fully coun-
terclockwise (RD7 will light). Then you must move the potentiometer 
wiper to a center position causing RD5 to light up. When this happens, 
the test is complete. This test must be completed in 8 seconds or else the 
test is considered failed.

Tone Test This procedure automatically tests the digital potentiometer and analog 
operational amplifier. A sine wave, generated using the digital potentiom-
eter, is sent through the Op Amp circuit to the ADC of the dsPIC DSC 
device. The sine wave is analyzed to determine if a smooth sine wave 
has been generated. If all works well, the test passes. If there is a fault in 
the op amp or digital potentiometer, then this test fails.
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If any of these tests fail, then at the end of the Tone test the LED corresponding to the 
failed test will blink slowly (2 blinks/sec). For example, if RD4 blinks, it means that the 
UART test failed. The table below correlates the blinking LED with each test and 
indicates the possible cause for the failure:

If all tests passed, then none of the LEDs will blink.

Blinking LED Test Failed Reasons for Failure

RD4 UART UART driver chip failed; UART shorting
jumper not connected on J1

RD5 Keypad S1 and S2 not working properly
RD6 Potentiometer Potentiometer R13 faulty
RD7 Digital Potentiometer/Op Amp Digital Potentiometer/Op Amp failed 
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NOTES:
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Chapter 4.  dsPICDEM� Development Board Hardware
4.1 HARDWARE OVERVIEW
This chapter describes the dsPICDEM 80-Pin Starter Development Board hardware. 
The dsPICDEM 80-Pin Starter Development Board features the hardware elements 
shown in Figure 4-1 and identified in Table 4-1

FIGURE 4-1: dsPICDEM� 80-PIN STARTER DEVELOPMENT BOARD

TABLE 4-1: dsPICDEM� 80-PIN STARTER DEVELOPMENT BOARD 
HARDWARE ELEMENTS

No. Hardware Element No. Hardware Element
1 Power Supply Selector (Section 4.1.10) 13 Analog Potentiometer (Section 4.1.2)
2 Voltage Regulator (Section 4.1.10) 14 Line In/Out Header (Section 4.1.16)
3 Power Jack (Section 4.1.17) 15 Low-Pass Filter (Section 4.1.6)
4 Diode Bridge (Section 4.1.10) 16 Digital Potentiometer (Section 4.1.5)
5 Test Points (Section 4.1.10) 17 I/O Port Header (Section 4.1.9)
6 32.768 kHz Crystal Oscillator (Section 4.1.12) 18 Push Button Switches (Section 4.1.3)
7 Power-on LED (Section 4.1.11) 19 LED Activation Header (Section 4.1.4)
8 7.37 Crystal Oscillator (Section 4.1.12) 20 LED Indicators (Section 4.1.4)
9 External Oscillator Socket (Section 4.1.12) 21 Master Clear Switch (Section 4.1.13)

10 dsPIC® DSC/PIC24 Device Header (Section 4.1.8) 22 ICD2 Jack (Section 4.1.7)
11 Prototyping Area (Section 4.1.14) 23 UART (Section 4.1.1)
12 Factory Test Socket 24 RS-232 Serial Port (Section 4.1.1)

1 2 3
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5

6

7
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9

8

21 22 23 24

20
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4.1.1 RS-232 Serial Port
One RS-232 serial communication channel is provided on the board. This channel is 
labeled J1. The dsPIC DSC or PIC24 MCU UART channel 1 U1RX and U1TX pins are 
connected to an RS-232 level shifting MAX3232CD (U3), as shown in Figure A-3. The 
serial port is configured as DCE and can be connected to a PC using a straight through 
cable. 

4.1.2 Analog Potentiometer 
An analog potentiometer (R13) is connected to analog channel AN2 on the dsPIC DSC 
or PIC24 MCU device. The voltage output range for the potentiometer is 0-5 VDC. The 
voltage source is provided by the +5VAN regulator, as shown in Figure A-6.

4.1.3 Push Button Switches
Two push button switches (S1 and S2) are connected to port pin RA12 and RA13, 
respectively, on the dsPIC DSC or PIC24 MCU device, as shown in Figure A-3. The 
signal lines are normally pulled up to VDD through 4.7K resistors. Pressing the switch 
shorts the line to ground. Port pins RA12 and RA13 are configured as input pins.

4.1.4 LED Indicators
Four LED indicators (D2 to D5) are connected to port pins RD4 to RD7, respectively, 
on the dsPIC DSC or PIC24 MCU device. The anode of each LED is tied to VDD 
through a 470 ohm resistor, as shown in Figure A-3. The cathodes are shorted and 
connected to GND by an activation header (J4). The LEDs are labeled RD4 through 
RD7 on the board to correspond to their respective port pins. 

4.1.5 Digital Potentiometer
A single channel digital potentiometer (U2) is provided on the development board. The 
MCP41010_SO150 digital potentiometer is controlled by the SPI2 communication 
channel on the dsPIC DSC or PIC24 MCU device. The output of the digital 
potentiometer is applied to a 2nd-order, low-pass filter, with a cutoff frequency of 
approximately 4 kHz. The output of the LP filter is connected to the LINE OUT pin of 
J9, as shown in Figure A-6.

4.1.6 Low-Pass Filter
A Microchip MCP6022_SO8 Operational Amplifier is configured as a 2nd-order, 
low-pass filter for speech or voice input filtering, as shown in Figure A-6. The input to 
the filter is at the LINE IN pin of J9.

4.1.7 ICD 2 Connector
By way of the modular connector ICD (J3), the MPLAB ICD 2 can be connected for 
low-cost programming and debugging of the dsPIC DSC or PIC24 MCU device.

4.1.8 Device Header
Header P1 supports the processor adaptor boards. The processor adaptor boards 
enable quick change out of the device.

4.1.9 I/O Port Header
Header P2 is a two-row header with appropriate labels for I/O ports. This header allows 
the user to easily probe appropriate I/O lines.
DS51584B-page 34 © 2006 Microchip Technology Inc.



dsPICDEM� Development Board Hardware
4.1.10 Power Supply
The power supply furnishes +5V or +3.3V for the board (see the schematic in 
Figure A-4). Source power is provided by a +9V, AC/DC wall adapter through Diode 
Bridge CR1. An LM317 voltage regulator provides power (VDD and AVDD) to the 
respective processor pins and prototyping area. A ground trace connects all VSS 
points. 

4.1.11 Power-on Indicator
A red LED (D1) indicates the presence of power (see Figure A-4).

4.1.12 Oscillators 
The board provides two crystal oscillators. Y1 operates at 7.37 kHz, and Y2 operates 
at 32.768 kHz. A socket is provided for an external oscillator (Y3). The oscillator circuits 
are shown in Figure A-4.

4.1.13 Reset Switch
The MCLR Reset switch (S3) connected to the processor MCLR pin provides a hard 
reset to the dsPIC DSC or PIC24 MCU device. 

4.1.14 Prototyping Area
A prototyping area and associated header is provided which enables additional ICs and 
attachment boards to be added.

4.1.15 Sample Device
A sample part programmed with the demonstration code is included in the dsPICDEM 
80-Pin Starter Development Board kit. The 80-pin TQFP is soldered onto an adapter 
board that plugs into the device header connection (see Figure 4-2). 

4.1.16 Line In/Out Connector (J9)
Pins provide line input and output connections for the low-pass filter, as shown in 
Figure A-6.
� LINE_OUT � Output signal from digital potentiometer
� LINE_IN � Input signal for ADC

4.1.17 9 VDC Input Jack (J2)
An input jack for 9V external power supply.
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FIGURE 4-2: ADAPTER BOARD PLUGS INTO HEADER ON MAIN BOARD

Align Corners of PIM 
and Header P1

Plug-in Module (PIM)
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Appendix A. Drawings and Schematics
A.1 dsPICDEM 80-PIN STARTER DEVELOPMENT BOARD LAYOUT
Figure A-1 shows the parts layout for the dsPICDEM 80-Pin Starter Development 
Board.

FIGURE A-1: dsPICDEM� 80-PIN STARTER DEVELOPMENT BOARD 
LAYOUT
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A.2 dsPICDEM 80-PIN STARTER DEVELOPMENT BOARD SCHEMATIC
Figure A-2 provides a schematic diagram of the dsPICDEM 80-Pin Starter 
Development Board.

FIGURE A-2: dsPICDEM� 80-PIN STARTER DEVELOPMENT BOARD SCHEMATIC 
(SHEET 1 OF 5)
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FIGURE A-3: dsPICDEM� 80-PIN STARTER DEVELOPMENT BOARD SCHEMATIC 
(SHEET 2 OF 5)
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FIGURE A-4: dsPICDEM� 80-PIN STARTER DEVELOPMENT BOARD SCHEMATIC 
(SHEET 3 OF 5)
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FIGURE A-5: dsPICDEM� 80-PIN STARTER DEVELOPMENT BOARD SCHEMATIC 
(SHEET 4 OF 5)
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FIGURE A-6: dsPICDEM� 80-PIN STARTER DEVELOPMENT BOARD SCHEMATIC 
(SHEET 5 OF 5)
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